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Executive Summary 

Coastal landfills and hazardous waste sites pose a potential environmental threat to 
surface water bodies through the exchange of groundwater-bome contaminants. Because 
of this potential threat, there is a general requirement to determine if contaminants from 
these sites are migrating into marine systems at levels that could pose a threat to the 
environment. 

Increasingly, groundwater is recognized as a potentially significant, although poorly 
quantified, source of nutrients and contaminant materials to coastal ecosystems. Interest 
in quantifying the exchange between groundwater seepage and overlying surface water 
has increased due to potential impacts resulting from anthropogenic land uses. 
Groundwater discharge originates inland and carries with it contaminants or nutrients, 
dissolved or colloidal, that could impact the chemical budget of surface-water 
ecosystems. Previous studies clearly show that groundwater discharge into surface-water 
environments can significantly contribute to the water budget. This chemical and physical 
impact may be heightened in smaller bodies of water such as embayments or lagoons, 
due to their limited volume and restricted fluid exchange with the open ocean. 

A collaborative effort between the Environmental Sciences Laboratory at Space and 
Naval Warfare Systems Center, San Diego (SSC San Diego), the Naval Facilities 
Engineering Service Center (NFESC), and Cornell Cooperative Extension Marine 
Program was made to develop improved methods for (1) identifying the spatial location 
where exchange is likely to take place, and (2) accurately measuring the groundwater 
seepage across the sediment-water interface. This effort resulted in the development of 
the Trident probe and the UltraSeep system. 

The Trident probe is a sunple, direct-push system equipped with temperature, 
conductivity, and water sampling probes. A measured contrast in temperature and/or 
conductivity between surface water and groundwater can be used to determine potential 
areas of groundwater impingement into the surface water. The water-sampling probe is 
used to collect in situ water samples for detailed chemical characterization of 
contaminants. 

Once potential areas of groundwater impingement are identified, the UltraSeep Meter can 
be used to make continuous, direct measurements of the groundwater seepage rate using 
an ultrasonic flow meter. The UltraSeep system also contains a multi-sample, water- 
sampling system that can pump water to six sequential sampling bags mounted around 
the perimeter of the meter. Conductivity, temperature, and pressure sensors are also 
mounted on the unit. 

In this document, the initial hardware development, testing, and field protocols are 
described for new techniques used to identify potential areas of groundwater 
impingement into surface waters (the Trident probe), as well as techniques for 
quantifying the flow rates and contaminant levels of groundwater at the surface-water 
interface (the UltraSeep System). 
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INTRODUCTION 

Coastal landfills and hazardous waste sites pose a potential environmental threat to 
surface water bodies through the exchange of groundwater-bome contaminants. Many of 
these sites are located adjacent to harbors, bays, estuaries, wetlands, and other coastal 
environments. Because of this potential threat, there is a general requirement to determine 
if contaminants from these sites are migrating into marine systems at levels that could 
pose a threat to the environment. 

Increasingly, groundwater is recognized as a potentially significant, although poorly 
quantified, source of nutrients and contaminant materials to coastal ecosystems. Ground- 
water discharge (seepage) into coastal and surface-water environments has been studied 
extensively usmg various methods (Lee, 1977; Lee and Cherry, 1978; Taniguchi and 
Fukuo, 1993; Cable et al., 1996; Moore, 1999; Li et al., 1999; Chadwick et al., 1999; 
Paulsen et al., 2001; Simmons, 1992; Moore, 1996; Valiela and D'Elia, 1990; Montlucon 
and Sanudo-Wilhelmy, 2000). The primary driver for seepage in near-shore environments 
is probably the discharge from land to surface water induced by the hydraulic gradient in 
the terrestrial aquifer. However, significant contribution to seepage may also derive from 
groundwater cu-culation and oscillating flow induced by tidal stage (Simmons, 1992; Li 
et al., 1999). In coastal areas with strong tides, tidal mixing zones may form from the 
movement of seawater into the aquifer (Figure 1). This tidally mixed zone can be 
important in controlling the exchange of groundwater due to a process called tidal 
pumping (Moore, 1996). Tidal pumping is when seawater mixes with groundwater at 
high tide, and then as the tide recedes, the mixture of seawater and groundwater is drawn 
out into the coastal waters. Because this process repeats every tidal cycle, appreciable 
volumes of groundwater can be extracted over time (Moore, 1996; Valiela and D'Elia, 
1990). 

Interest in quantifying the exchange between seepage and overlying surface water has 
increased due to potential impacts resulting from anthropogenic land uses. As mentioned 
above, groundwater discharge originates inland and carries with it contaminants or 
nutrients, dissolved or colloidal, that could impact the chemical budget of surface-water 
ecosystems. For example, Montlucon and Sanudo-Wilhelmy (2000) concluded that 
groundwater discharge into Flanders Bay on Long Island, NY, accounts for up to 37% of 
the copper distribution in the bay . They also estimated that seepage accounts for 
approximately 40% of the total river inputs in a study area in the South Atlantic Bight. 
These studies clearly show that groundwater discharge into surface-water environments 
can significantly contribute to the water budget. This chemical and physical impact may 
be heightened in smaller bodies of water such as emba5mients or lagoons, due to their 
limited volume and restricted fluid exchange with the open ocean. 

Several measurement techniques have been proposed and implemented over the past 25 
years. Lee (1977) made the first breakthrough in quantifying seepage into surface waters. 
This breakthrough involves a device consisting of a cut-off section of a 55-gallon drum 
(area, 0.255 m^) in which the open-end is inserted into the sediment. Attached to the 
drum via an outflow port is a 4-1 plastic bag that collects the seepage. The volume of the 
bag and sampling interval are recorded and the specific discharge is obtained by dividing 



the volume of collected seepage by the area of the drum. Although generally quite 
effective, various errors associated with the device must be corrected before sampling 
(Shaw and Prepas, 1989; Belanger and Montgomery, 1992). Another disadvantage to this 
method is that it is quite labor-intensive because the plastic bags must be monitored and 
replaced continuously. 

Cherkauer and McBride (1988) overcame some of these shortcomings by designing a 
remotely operated seepage meter. Plastic collection bags were used, but separate 
chambers were installed so that samples could be collected remotely. This meter did not 
require manual installation, but it was heavy enough to sink into the bottom sediment as it 
was lowered. The major drawback to this seepage meter was that with a weight of greater 
than 150 pounds, it was not very portable, could only be used in large water bodies, and 
might distort flow paths slightly as it was sealed into the bottom 

Further advancement of the Lee (1977) technique came from Chadwick et al. (1999). 
Their meter consists of six chambers capable of automated measurements. Attached to 
each chamber is a plastic collection bag that collects seepage over a specified time 
interval. Seepage is collected until all six chambers have taken measurements. 

A major advance in quantifying transient seepage came from Taniguchi and Fukuo 
(1993). Their seepage meter is based on a thermal perturbation technique and can 
continuously record specific discharge. Although divers are still needed, the deployment 
and measurement of seepage is much less labor-intensive than previous methods. Another 
method used by Mcllvaine (1998) infers groundwater discharge across the sediment- 
water interface through pressure gradients using the Portable In-Situ Pore Pressure 
Instrument II (PISPPI). The pressure gradients are recorded during the recovery of a 
negative pressure pulse that is generated using a hand-held pump connected to the probe 
of the instrument. This instrument can also measure the hydraulic conductivity of the 
sediment. 

Building on these historical advances, a collaborative effort between the Environmental 
Sciences Laboratory at Space and Naval Warfare Systems Center , San Diego (SSC San 
Diego) and Cornell Cooperative Extension Marine Program set out to develop improved 
methods for (1) identifying the spatial location where exchange is likely to take place, 
and (2) accurately measuring the groundwater seepage across the sediment-water 
interface. In this document, we describe the initial hardware development, testing, and 
field protocols for new techniques for identifying potential areas of groundwater 
impingement into surface waters (the Trident probe), as well as techniques for 
quantifying the flow rates and contaminant levels of groundwater at the surface-water 
interface (the UltraSeep System). 
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Figure 1. Conceptual representation of coastal contaminant migration 
process and associated groundwater-surface water interaction. 

HARDWARE DESCRIPTION 

The Trident Probe 
To identify potential areas where groundwater is entering the surface water, we have 
developed the Trident Probe (Figure 2), a simple direct-push system equipped with 
temperature, conductivity, and water-sampling probes. Contrasts in temperature and 
conductivity between surface water and groundwater are used to determine likely areas of 
groundwater impingement. The water-sampling probe can then be used to collect samples 
for detailed chemical characterization of contaminants. 

The temperature sensor consists of a customized Sea-Bird Electronics, Inc. SBE 38 
digital oceanographic thermometer with a ruggedized, 60-cm long titanium probe. The 
sensor has a measurement range of-5 to +35 °C at an accuracy of 0.001 °C, and a 
resolution of 0.00025 °C. The sensor response time is about 500 milliseconds. The sensor 
housing is titanium, with a depth rating of 10,000 meters. Real-time temperature data are 
transmitted from the unit in ASCII format via RS-232 at a frequency of about 2 Hz. 
Areas of groundwater seepage may appear either as warm or cold contrast to the surface 
water, depending on the seasonal and site characteristics. 
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Figure 2. Schematic and photo of Trident probe, showing conductivity, 
temperature, and water-sampling probes. 

The conductivity sensor uses a custom, small-diameter, stainless-steel, Wenner-type 
probe, 60-cm long. The probe is configured with two pairs of stainless-steel electrodes. A 
constant current is imposed through the outer pair, and the voltage is monitored through 
the inner pair. Both pairs of electrodes are coupled through an underwater connecter and 
cable to a standard Geoprobe® model FC4000 deck unit that controls the outer electrode 
pair current, monitors the inner electrode pair voltage, and sends the corresponding raw 
conductivity signal to a laptop computer via an RS-232 port. The laptop applies 
calibration and temperature corrections to the signal, and records and displays the results. 
The conductivity signal varies primarily as a function of changes in salinity, and 
secondarily, as a function of clay content and porosity (Figure 3). Areas of likely 
groundwater seepage are generally associated with low conductivity, either as a resuh of 
low salinity, low clay content (high permeability), or both. 

The water-sampling probe allows interstitial waters to be extracted from the sediment 
at selected depths up to about 60 cm below the sediment-water interface. Porewater is 



collected by syringe or vacuum pump extraction through a small-diameter, Teflon®- 
coated, stainless-steel probe (see Figure 2). The probes are Vi-inch-diameter, stainless- 
steel tubing fitted with a solid point. On the side of the tube near the tip, there is a sample 
port consisting of a slot covered by a small mesh size (241-)j.m), stainless-steel screen. 

The three probes are collocated in a triangular pattern, with a spacing of about 10 cm on 
an aluminum mounting base. Coupled to the mounting base is a submersible air hammer 
that assists in driving the probe into the sediment. On the top of the air hammer is a 
couplmg for a 2-m aluminum push rod that can be sequentially lengthened in 2-m 
increments to a total length of about 10 m. A bundled cable including the temperature and 
conductivity signals, Teflon® sampling tube, and pneumatic air hammer hose runs from 
the probe to the surface. The sensor signals from the temperature probe and the 
conductivity deck unit are linked to a laptop computer with real-time display via a 
graphical MATLAB® interface. The Global Positioning System (GPS) is also coupled to 
the laptop to simultaneously record the sampling locations. 
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Figure 3. Response of Trident conductivity probe to changes in salinity and sediment 
type. 



In operation, the Trident probe can be deployed in several ways, depending primarily on 
the depth of the site. In very shallow water (0 to 1 m), the operator simply walks or wades 
to the sampling station and manually pushes the probe to the desired depth. Experience 
has shown that the probe pushes easily by hand to a depth of about 30 cm. The air 
hammer, or a slide hammer, can then complete the push, if necessary. In water of 
moderate depths (1 to 10 m), the probe is easily deployed from a small boat using the 
push rod in combination with the air hammer (Figure 4). It is important that the boat be 
well-anchored to minimize lateral loading on the probe during the insertion. In deeper 
water (>10 m), a diver can deploy the probe (Figure 5), or it can be attached to a landing 
frame. 

Figure 4. Deployment of Trident probe from small boat 
using push rod and air hammer. 

Figure 5. Diver using air hammer to deploy Trident probe. 



The UltraSeep Meter 
The UltraSeep Meter combines the continuous, direct measurement of groundwater 
seepage rates using the time-transient ultrasonic technique described by Paulsen et al. 
(2001) with a multi-sample, water-sampling system similar to that described by 
Chadwick et al. (1999). The meter relies on a Teflon®-coated, stainless-steel, open- 
bottomed chamber measuring 48 x 46 cm to flirmel the seepage water to the flow sensor. 
The flow sensor is connected to the high point of the fiiimel via 12-mm Teflon® tubing, 
allowing free flow of water between the fiinnel and the outside environment. A W.S. 
Ocean Systems (now EnviroTech) ESM data logger/controller unit monitors data from 
the flow meter. Based on the measured flow conditions, the ESM activates a water- 
sampling system that can pump water to six sequential sampling bags mounted around 
the perimeter of the meter. The ESM also records data from conductivity, temperature, 
and pressure sensors mounted on the unit. All these components, along with a 12-V 
submersible battery housing, are mounted within a 74-cm-diameter by 79-cm high 
cylindrical aluminum frame (Figure 6). 
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Figure 6. Side view schematic and piioto of UltraSeep system. 

The uhrasonic flow sensor uses two piezoelectric transducers to continuously measure 
the travel times of ultrasonic waves along the flow path of the seepage water through the 
flow tube. As water enters the flow tube, it passes through the ultrasonic beam path. The 
ultrasonic signal that travels with the flow has a shorter travel time than the signal 
traveling against flow. The perturbation of travel time is directly proportional to the 
velocity of flow in the tube. The flow sensor sensitivity is about 1.5 cm^/min, which, 
given the amplification from the funnel, translates to a seepage rate of less than 1 cm/d. 
Signal averaging can improve this sensitivity further. A Teflon®, electrically activated 
solenoid valve coimected in line with the flow tube easily establishes the sensor's zero- 
flow point. 



Figure 7. Functional schematic of UltraSeep system, showing the feedback system that 
regulates water sampling in proportion to seepage rate. 

The ESM unit provides the primary data logging and control functions for the UltraSeep 
meter. The ESM allows programmable logging and control via analog, digital, and 
RS-232 signals. For the UltraSeep system, the flow sensor data are recorded as an analog 
signal. Typically, the control program evaluates this signal for a 5-minute averaging time 
and, based on the laboratory flow calibration, determines the current seepage rate. If the 
seepage rate is positive, the ESM activates the water-sampler pump via RS-232, and sets 
the pumping rate slightly lower than the current seepage rate. After a 5-minute sampling 
period, the flow signal is again evaluated, and the process is repeated. Approximately 
every 2 hours, the ESM activates the sampling valve via RS-232 and switches to a new 
sampling bag (Figure 7). 

The water sampler consists of a high-accuracy, low-flow-rate, peristaltic pump connected 
in line with a selector valve. Both units are housed within a submersible pressure case. 
The pump (Meredos model HP60) allows sampling at user-specified flow rates ranging 
from about 0 to 18 ml/min. The selector valve (Valco Instruments) has six outlet ports 
and one inlet port. All water contact parts in the sampling system are constructed from 
KYNAR® or Teflon* with the exception of the PharMed* pump tubing. 

In operation, the UltraSeep meter is lowered to the bottom, either directly from a boat or 
by divers using a lifl-bag. Once the unit is settled on the bottom, divers check the seal. A 
period of 2 to 3 hours is generally allowed to ensure that any transient seepage response 
associated with the deployment activities has dissipated. The ESM unit then initiates 
logging and control functions. At coastal sites, a typical deployment runs over a 12- to 
18-hour period to capture an entire semi-diurnal tidal cycle, although the system can be 
run continuously for about 4 days. During this period, the seepage rate is continuously 



monitored, and up to six water samples are collected for chemical analysis. At the end of 
the deployment, the meter is recovered using either a lift line to the recovery boat, or by 
diver assistance. The meter data are then downloaded and the Teflon® sample bags 
recovered (Figure 8). 

Figure 8. Teflon  sampling bag. 



TRIDENT PROBE PROTOCOLS AND PROCEDURES 

Planning Deployment 
The Trident probe can be deployed in various ways, depending on the site characteristics 
and resources available (Figure 9). For shoreline sites where sampling occurs onshore or 
in shallow waters accessible by wading, the Trident probe can be directly inserted into 
sediments. A segmented push-pole is used to deploy the probe in waters up to 30 feet 
deep; the pole sections are 6 feet long and can be lengthened or shortened according to 
depth. Divers can directly insert the Trident probe or it can be mounted into a frame and 
lowered by surface craft. Each method requires different support equipment, but the 
following procedures cover the Trident system. 

There are five major pieces of equipment required to operate the Trident system: (1) the 
Trident probe, (2) the communications/pneumatic cable, (3) Geoprobe^'s FC4000 field 
computer, (4) a laptop computer with the proper system requirements, and (5) a hand- 
held GPS unit with an RS-232 interface. In many cases, a 12-V deep-cycle car battery 
and 750-watt power inverter will be required for portable power. Appendix A provides a 
pre-deployment checklist to ensure all necessary items are considered. 

Figure 9. (Left to right) shallow-water (0 to 3 ft) T-bar, mid-range (3 to 30 ft) push-pole, 
and deep-water (>30 ft) deployment methods for Trident probe. Diver method not 
shown. 

Equipment Setup Procedures 

Pneumatic Hammer 
The Trident probe may require a built-in pneumatic hammer to insert the probe into 
sediments and need checking before use. It is important to oil the hammer occasionally to 
ensure proper lubrication of the hammer. Place several drops of pneumatic oil into the 
pneumatic hose connector on the input side for every 5 minutes of actual air operation 
(most pneumatically assisted probe insertions only require several seconds of hammer 
operation). Also apply a small amount of corrosion preventative behind the sliding collars 
on the female pneumatic hose connectors before deployment and after rinsing. Attach the 
regulator to a SCUBA tank and connect the hose to the input connector on the hammer 
housing, marked "IN". Slowly open the valve on the SCUBA tank to activate the 
hammer. You may want to hold a towel over the output connector on the housing, as 
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some oil will be ejected. The hammer will vibrate at an increasing frequency as the 
SCUBA tank valve is opened ftirther, increasing air flow. You do not have to fully open 
the tank valve to operate the hammer. It is important to make sure the hammer has proper 
lubrication before storing, to prevent corrosion. You can use a hammer extraction tool 
(Figure 10) to remove/install the air hammer if service is necessary as described in the 
Maintenance section of this document. 

Figure 10. Air hammer extraction tool. 

Trident Cable Assembly 
The Trident cable assembly is connected to the probe at the following five points: 

• Inlet port on the pneumatic hammer housing 

• Outlet port on the pneumatic hammer housing 

• Quick-connect for the porewater sampler 

• Probe connections for temperature 

• Probe connector for conductivity 

It is crucial to make sure the pneumatic hose connections are properly made to prevent 
water from leaking into the hammer assembly and to supply/vent air correctly. A 
Swagelok quick-connect secures the sampling line to the porewater probe. Use the 
following procedure to make the pneumatic hose cormections: 

1. Push the male side of the connector attached to the sampling line into the female 
connector on the probe until it clicks (this type of connector is open only when the 
halves are properly coupled). 

2. Attach the two cable cormectors from the "Y" mold onto the temperature and 
conductivity probes. 

11 



• 

• 

3. Depending on the deployment method, zip-tie the Trident cable assembly to the short 
pipe extension coming from the hammer housing or onto the first section of the push- 
pole to prevent stress at the connections. 

The surface portion of the Trident cable assembly requires connections at three points: 

• Geoprobe® FC4000 field computer for the conductivity probe 

Interface cable for the temperature probe 

Quick-connect on the SCUBA regulator hose 

Follow this procedure to make the surface portion connections: 

1. Attach the 8-pin connector on the cable coming from the "Y" mold to the connector 
labeled "PROBE" at the rear of the FC4000 field computer. The f4-pin temperature 
cable coming from the other side of the "Y" mold is coupled to temperature interface 
cable having a 25-pin connector at the other end. 

2. A 9-V battery connected to a mount on the adaptor cable provides power for the 
temperature probe. Secure battery to cable with zip-tie or tape. 

Laptop Connections 
A quad serial card is used to interface the GPS unit, the temperature probe, and the 
Geoprobe® FC4000 field computer with the laptop. The quad card connections are as 
follows: 

• COM 4 to RS-232 serial splitter cable to the GPS 9-pin serial cable to GPS unit 
• COM 5 to 25-to-9-pin RS-232 serial cable to temperature interface cable 
• COM 6 to RS-232 serial cable to "COM 2" on back of FC4000 

Geoprobe® Field Computer 
The Geoprobe® FC4000 field computer is the standard unit Geoprobe® uses for their 
larger commercial conductivity probes. The unit powers the Trident conductivity probe 
and translates conductivity signals to numerical values for output to the GUI laptop. The 
conductivity probe is constantly powered by the FC4000 and data continually stream 
fi-om the COM 2 serial port on the back of the unit. The real-time conductivity data are 
only viewed on the GUI when the "Activate Probe" button is selected, and are collected 
when the "Capture" button is used. 

Turn on power to the FC4000; the switch is on the rear panel. The contrast dial on the 
fi-ont may have to be adjusted if no image is on the screen. The following menu will 
appear: 

Select an Option (select #1, conductivity) 
Select a Probe Option (select #1, SC4{X)) 
Select an Option (select #2, to bypass all tests) 
Select Rod Length Used (select #2, for 2-foot rods) 
Select an Option (select #1, for wenner) 

12 



You will see a Conductivity versus Depth graph appear on the screen. When the FC4000 
is used with the Trident GUI, this graph screen remains blank. To see the data plotted on 
the FC4000 graph, turn on the "Trigger" switch on the front of the unit and connect the 
"stringpot" switch to the rear of the unit. Conductivity data are plotted on the graph when 
the "stringpot" switch is activated. The depth data that appear are not representative of 
the probe depth but can serve as a reference to the data collected (due to the application 
of the Geoprobe® FC4000 with a custom probe). 

Trident GUI 
A MATLAB® GUI has been developed to simultaneously capture data from the Trident 
probes and GPS unit for real-time mapping of conductivity and temperature (Figure 11). 
Install this software onto a laptop with the proper requirements to run MATLAB®. 
"Chart View®," which is an electronic navigation software, can be added to the laptop for 
navigation. If the temperature/conductivity plotting capabilities are required, you must 
create a digitized chart of the area. Several windows on the GUI display real-time values 
and graphs of temperature and conductivity along with a map display of sampled 
locations with their values (temperature or conductivity) represented by colored graphics 
(Figure 9). The Geoprobe® FC4000, the temperature probe, and the GPS unit must be 
powered before the "Activate Probes" button is selected on the GUI (see Appendix D for 
detailed GUI operations). 

Individual files are created each time the "Capture" button is activated. Filenames are 
created using the "Station ID" entry followed by the date (automatic). All time references 
are based on the time set in the laptop computer. Before capturing data, it is important to 
allow approximately 1 minute for the temperature and conductivity probes to respond. 
Observe the temperature and conductivity graphs to see when the readings stabilize 
before capturing data. 
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Figure 11. Trident GUI display showing map of survey area 
with color-assigned values at GPS-referenced sample points. 
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Deploying Trident Probe 
The Trident probe can be deployed by using a push-pole, a diver, a deployment frame, or 
simply by hand. The deployment method depends on the site characteristics and 
resources available. For above water and shallow water sites accessible by walking or 
wading, a sled, vehicle, or cart containing all the support equipment allows transport of 
the Trident system along a shoreline. The push-pole deployment method can be used 
from a small boat in water up to 30 feet deep and diver or frame deployment can be used 
in deeper water. 

Shore Deployment 
For shore-based deployments, configure the electronics of the Trident system on a stable 
and portable platform. Although the hand-held GPS can move several feet from the main 
electronics to mark a position, an extension cable on the GPS unit allows more flexibility 
when moving from sample point to sample point. This flexibility can also be 
accomplished by using an external antenna with a longer cable. Once the Trident cable 
assembly has been connected to the probe and the system is ready to display data, the 
Trident probe can be inserted into the sediment by hand at depths up to 2 feet. A threaded 
push-pole can be attached to the probe for wading operations. 

Push-Pole Deployment 
Trident probe deployments in water depths up to 30 feet deep can be performed from a 
small boat using the push-pole method. Six-foot sections of pole are combined to 
accommodate depth and can be assembled as the probe initially descends and decoupled 
upon retrieval or left intact. Configure the push-pole to remain attached to the probe 
when set in soft sediments, but configure it to detach from the probe when set in firmer 
sediments. In this configuration, the probe is retrieved via the cable assembly (see 
below). 

Rigid Coupling 

Deploying the Trident probe while leaving the push-pole attached presents certain 
conditions that require attention. You must remain stationary over the site to prevent 
lateral forces on the probe if the push-pole is physically held while the Trident probe is 
operating. A 3-point anchor can hold the probe; anchors can be set past each end of the 
transect, another set perpendicular (astern), and lines made taunt. Positions can be 
adjusted along the transect by slacking one anchor line and pulling in on the other. In 
many cases, once the Trident probe has been set into the sediment, the push-pole will 
remain vertical after release, as long as the height of the push-pole above the water 
surface is kept to a minimum. If this is the case, the boat position should be maintained 
close to the push-pole without the possibility of drifting into the pole or pulling the 
Trident probe out of the sediment via the cable assembly. 

Detachable Coupling 

To decouple the push-pole from the Trident probe, the short section of pipe with two 
short rods protruding from each side is threaded onto the top of the air hammer housing. 
The initial push-pole that attaches to the Trident probe for this purpose has slots that 
engage these rods with a counterclockwise push-and-twist motion (Figure 12). A spring, 
tethered to the pole connector, is placed between the two connectors before being 
coupled. This spring keeps the probe attached until probe placement is completed. A 
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clockwise twist on the push-pole disengages the probe. The pole can then be pulled from 
the water while the Trident probe remains in place. This bridle relieves stress on the 
probe connections when the cable assembly is used to pull the probe back to the surface. 
A stress relief bridle on the hammer housing is fastened to the cable assembly, which 
leaves slack on the probe connections when taunt. 

Figure 12. Detachable push-pole coupling. 

Setting Trident into Sediment 
Lower the Trident probe with the push-pole while maintaining minimal slack in the cable 
assembly until it contacts the sediment and continue to push the probe until it is set. In 
firmer sediments, you must use the air hammer to assist the insertion. Turn on the 
SCUBA tank valve while pushing on the pole until the Trident probe can no longer be 
inserted further. You can bend the probes if objects are buried in the sediment. Hard 
objects such as rocks can be felt via the push-pole. Reposition the Trident probe if there 
is any question of striking hard objects. If the Trident probes get bent, they can be easily 
straightened by hand. 

Diver Deployment 
The Diver method for deploying the Trident probe offers rapid repositioning between 
sample locations but requires communication between topside and the divers. An 
underwater communications unit allows verbal communications between divers and 
Trident GUI operators, but simple signals can be worked out if an underwater 
communications unit is not used. A partially submerged metal pipe struck by a hammer 
can produce audible signals for communications to the divers. A buoy with a line held by 
a diver can be bobbed on the surface for return visual communications. Communications 
would be necessary for repositioning the Trident probe, actuating the air hammer, and for 
confirming placement. A measuring tape or marked line marks a transect along the 
bottom and guides the divers positioning the probe. The Trident probe is set up with a 
short section of pipe threaded into the hammer housing so it can be used as a handle. 
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Frame Deployment 
The Trident probe can be mounted into a frame for deployment from a support vessel's 
davit. Although this method was never used during development, the concept is straight- 
forward. A 4-foot pipe, threaded into the top of the Trident air hammer housing, passes 
through a plastic guide at the top of a 3-foot high deployment frame. A locking pin, 
placed through a hole in the pipe above the guide secures the Trident probe within the 
frame when out of the water. A shackle attached to the top of the pipe connects the davit 
cable. Once the Trident probe and frame are suspended for deployment, the locking pin is 
removed. The Trident is lowered to the bottom and the air hammer is actuated for 
insertion. 

Porewater Sampling 
The Trident probe allows the collection of porewater at the same depth the conductivity 
and temperature are measured, up to 2 feet into sediment. Attach the priming syringe to 
the closed luer-lock valve on the 1/8-inch Teflon® tubing coming out of the cable assem- 
bly, pull vacuum on the syringe, and lock the plunger using the locking rod (Figure 13). 
Open the luer-lock valve and allow the priming syringe to collect 50 ml of water to prime 
for sample. If 50 ml of water is not collected, close the luer-lock valve, disconnect the 
syringe, empty, and repeat vacuum until a total of 50 ml has passed through the sampler. 
Repeat this process with the sample syringe, evacuating air from syringe only if neces- 
sary, until sample size is acquired. Larger porewater collections can be made using a 
sample bottle plumbed between the Trident sampler and a vacuum pump. Note that some 
sediments are not conducive to direct porewater sampling due to fine grain size. It may 
help to push a few milliliters of water through the sampler, using the priming syringe as 
the probe moves down through the sediment. 

Clean the porewater sampler before each sample collection. Place the tip of the porewater 
sampler into a collection container and push 100 ml of warm Alconox® solution (2%) 
through the sampler with a specified syringe. Follow this cleaning with 100 ml of 
deionized (DI) water, using a syringe dedicated for this purpose. 
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Figure 13. Syringe with locking rod through plunger. 

Maintenance 
Thoroughly rinse off the Trident probe and cable assembly while all probe connections 
are still in place. Pay particular attention to the pneumatic fittings. Put the porewater 
probe tip in a container of freshwater and, using the priming syringe, draw at least 100 ml 
of freshwater through the porewater sampler to rinse and remove any particulates. 
Remove the probe tip from the container and draw remaining water from the sampler and 
line. If the sampling line was exposed to any free product, you should flush line with 
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warm Alconox® before rinsing. Disconnect cable assembly and place a few drops of oil 
into the air intake port of the pneumatic hammer. Apply an anti-corrosive to the 
pneumatic quick-connects. 

The pneumatic hammer should provide long service when properly lubricated and 
protected from water entry. If you must access the hammer, remove the top cover plate 
on the housing and use the air hammer tool to unscrew the hammer assembly. The 
hammer assembly has only three parts: the cylinder, the piston, and the valve body. Lift 
the valve body off the hammer cylinder to access the piston. Clean and lubricate the 
piston and cylinder with light oil. Apply grease to the threads on the cylinder, replace the 
valve body, and use the air hammer tool to screw the hammer assembly into the housing. 

ULTRASEEP PROTOCOLS AND PROCEDURES 

Planning Deployment 
Planning the deployment period of the UltraSeep is important, as maximum seepages 
occur during periods of extreme tidal cycles. If a single tidal period of approximately 
12 hours is sampled. Start the sampling sequence at the beginning of the high tide. If 
sampling occurs over several days, you might want to start the sampling sequence just 
before a high or low tide. 

Before heading out to the field, make sure you have all necessary items for the 
deplojonent. Appendix C covers all the items required for using the UltraSeep. Set up 
programs for the UltraSeep before fieldwork so that pre-deployment programming goes 
quickly. Clean UltraSeep surfaces that come in contact with sample waters (sample 
tubing and interior of ftinnel) and attach sample bags before deplo3anent. 

Battery Charging 
The UltraSeep uses the latest in battery technology to power the meter up to 4 days while 
providing exceptional safety during transport and handling. A 12-V, 105-Ah, deep-cycle, 
aggregate glass matt, sealed battery supplies power. While this type of battery technology 
minimizes off-gassing, vent the battery housing while charging to prevent explosion 
(also remove the threaded plug at the top of the housing during storage). Before charging, 
remove the threaded plug from the top of the battery housing and insert tubing at least 10 
inches into the housing (Figure 14). This tubing can be coimected to a low-flow air 
source or an aquarium air pump, which provides a positive airflow during the charging 
phase. 
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Figure 14. Top of the battery housing showing power 
connector and vent hole (without plug). 

To maintain optimum battery performance, the battery should be tlilly charged before 
storage and recharged once every 4 months. The charging unit, a CT Chargetek 500, is 
fully automatic and can be left on charge indefinitely, without damaging the battery. 
First, connect the charger to the battery via the 2-pin connector on the top of the housing. 
These connector pins are "hot," so prepare the area so that nothing will inadvertently 
short the pins, which could cause permanent battery damage and a possible explosion. 
Once the charger is connected to the battery, plug the unit into a standard 115-V outlet. It 
is highly unlikely, but if the "service" light on the charger illuminates, unplug the 
charger and test for possible causes. The red "fast" charge light will remain on until the 
battery has received sufficient charge and the light illuminates green, indicating a "float" 
charging phase. It is preferable to leave the battery charging on "float" for several hours, 
but is not necessary. Unplug the charger from the AC outlet before disconnecting the 
charger fi-om the battery. Inspect the threaded plug at the top of the battery housing and 
wrap it with Teflon*^ tape before re-installing. 

Preparations for Cleaning 
The solutions used for cleaning the UltraSeep will differ according to the type of analysis 
performed. A warm 2% Alconox® solution is used in the cleaning process in preparation 
for sampling organic compounds (most common use) and a warm 2% Rutherford 
Backscattering Spectroscopy (RBS) solution for sampling metals. Nitric acid is used if 
metals are going to be measured and must be diluted to a concentration of 10%. The last 
fluid used in the process will be 18 mega-ohms of DI water. Teflon® sample bags are 
attached to the DI primed sample lines once the cleaning process is complete. See 
Appendix E for detailed cleaning instructions. 

Make sure the pump tubing inside the valve housing has been loaded into the pump head. 
Try not to disturb the knurled screw on the pump head; this screw controls the pressure of 
the rollers on the tubing and affects flow. The adjustment screw should be set to the 
manufacturer's specifications, but a 1 VA turn open from the fiill stopped position should 
be close. 
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Software 
Two programs are needed for programming the ESM-1 controller/logger and one for the 
MiniLogger. A text editor is needed to write/change the programming scripts for the 
ESM-1; the developers of UltraSeep use ConText Editor. The other is Hyperlink, which 
communicates with the ESM-1. Programs to run the ESM-1 for actual sampling are the 
"main" and "pump" files. Other programs are provided for decontaminating the meter, 
and for valve and pump testing. A program named "Flowm" is used to 
program/communicate with the MiniLogger. Create desktop shortcuts to find these 
programs easily. 

Preparing to Communicate with IVIeter 
Two components on the meter require computer programming before deployment. One is 
the ESM-1, a data logger/controller for the valve and pump, and the other is the 
MiniLogger for the ultrasonic flow meter. To communicate with the meter, the power 
cable on the meter must be connected to the battery. To connect a computer to the ESM- 
1, plug the wet-pluggable mini-connector cable from the small interface box into the 
ESM-1 (serial port 1) and the RS-232 (DB-9) connector from the interface box into the 
computer (Figure 15). The computer connection for the MiniLogger is made via the 100- 
foot MiniLogger communications/solenoid cable that has a "T" mold going to two shorter 
cables. One of these short cables, labeled "com mini", is then connected to the "mini 
logger com" cable having the DB-9 computer connector. Plug the female 3-pin cormector 
on the 100-foot cable into the male 3-pin connector on the MiniLogger and the DB-9 into 
the computer. A cover for the display panel on the MiniLogger must be left in place when 
outside, as sunlight affects the display and makes it unreadable until the panel cools. 

The uhrasonic flow meter requires "zeroing" once the UltraSeep is submerged; this 
procedure ensures accurate flow measurements and should be conducted for each 
deployment. A 24-VDC source is needed to supply power to the solenoid valve, plumbed 
in-line with the flow sensor. To activate the valve,, two, small, 12-V gel cell batteries 
connected for 24-V output can be used. While the solenoid valve is powered (closed), the 
water inside the flow tube is not moving and the flow meter can be zeroed. An adaptor 
cable has two leads for battery connections and is cormected to the short cable coming 
from the "T" mold, labeled "solenoid 24V". 

L "g Ill,,, •^ g ' 

Figure 15. ESM-1 computer interface. 
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Programming UltraSeep 
Program the MiniLogger before the ESM-1. Check the display panel on the top of the 
MiniLogger to make sure it is getting power; characters will be visible. Select the 
"Shortcut to Flowm" from your computer's desktop. Zeroing the flow sensor should be 
done after the MiniLogger and ESM-1 are programmed and the UltraSeep is in the water. 
See Appendix H for "zeroing" and programming procedures for the MiniLogger. 

Once the MiniLogger has been programmed, connect the ESM-1 interface box from the 
computer to serial port 1 of the ESM-1. If remote monitoring of the ESM-1 is desired, 
connect the 100-foot com cable between the interface unit and the ESM-1. Two files are 
uploaded to the ESM-1 for programming; these files are the "main" and "pump" files. 
The "main" file is edited and used to program the delay and sampling times, while the 
"pump" file is edited and used to control the pump. Details for programming the ESM-1 
are in Appendix G. Log the ESM-1 start time as well as the start time for the sampling 
sequence to determine sample periods for each sample bag and when the sampling 
sequence will finish. 

UltraSeep Deployment 
Review the pre-deployment checklist in Appendix D and ensure that the valve stems to 
the sample bags are in the open position. Remove wheels from the UltraSeep frame once 
the unit is suspended. Traditionally, divers have been used during deployment of the 
UltraSeep to facilitate priming the ultrasonic flow tube and ensuring a good placement 
into the sediment. Typically, the UltraSeep has been deployed into the water using a 
winch and release shackle attached to the meter's lift bridle. If the sediment site looks 
good for deployment directly under the UltraSeep, then it can be lowered to the bottom as 
long as the support boat is operating in calm waters. Lift bags are usually used and allow 
divers to maneuver the meter to a suitable location (Figure 16). It is important that the 
divers do not allow air bubbles to enter the ftinnel. 

Zero Flow Meter 
The ultrasonic flow sensor should be "zeroed" to provide accurate flow data. It is very 
important to prime the ultrasonic flow tube using the primer bulb to remove any air 
bubbles in the tube or under the fiinnel before zeroing. The fiinnel should be cleared first, 
followed by the flow tube using the suction side of the priming bulb. A 24-V source is 
attached to the MiniLogger cable to close the in-line solenoid valve during the zeroing 
process. 

The zeroing procedure can be performed after the UltraSeep has been set into the 
sediment. Use this method of zeroing if bottom-water temperatures are significantly 
different than temperatures at the surface. This method of zeroing requires the 
MiniLogger cable to remain attached to the meter. Once completed, cable ends are 
dummy-plugged before tossing the cable into the water. Use other zeroing options if it is 
preferable to deploy the UltraSeep without leaving cables attached. The unit can be 
suspended near the bottom while the flow sensor is zeroed, or it can be zeroed just under 
the surface if temperature and salinity are similar to benthic waters. Once zeroed, the 
UltraSeep can be brought onboard and the cables removed and dummy plugs put on 
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connectors. Priming the flow tube and removing bubbles from the fUnnel will have to be 
performed again. 

Figure 16. Diver using lift bag to deploy UltraSeep. 

Setting UltraSeep 
Gently lower the meter into the sediment to avoid disruption. The flange should be set 
level with the sediment surface. If sediments are extremely soft, it may help to have the 
lift bags or dive vests slightly more buoyant for a controlled push into the sediment. If 
force is required to insert the UltraSeep, use vertical pushing or "bouncing" on the meter 
frame. Use a slight back-and-forth rocking motion on the frame as a last resort. Relocate 
the UltraSeep if an object under the sediment surface interferes with placement. The idea 
is to place the meter into the bottom while minimizing disturbance of the sediment 
(Figure 17). 

The UhraSeep can be marked with a buoy, provided there is enough slack in the line to 
account for high tides over the course of the experiment and there is no threat of boat 
traffic or people to disturb the marker buoy. This marking also allows for recovery 
without the need for divers. The unit can also be tethered to a structure, such as a nearby 
piling, if marker floats are risky and recovery without divers is planned. In many 
situations, a marker float or tethered line attached to the meter is undesirable, but the 
meter can be relocated using a GPS unit or marker buoy anchored adjacent to the meter. 
If lines are attached, the possibility of the UltraSeep being disturbed must be considered a 
possibility and could affect measurements and samples. 
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The meter may also be deployed from shore if the waters are too shallow for a boat 
deployment. In this case, it may be useful to place the meter placed onto a makeshift sled 
to transport it to a location deep enough for the UltraSeep to operate (25 inches deep at 
lowest tide). Another option is to remove the battery from the frame to lighten the 
UltraSeep and power the meter from shore via the 100-foot power cable. The battery, if 
left on the frame, helps stabilize the meter and minimize any physical disturbances from 
passing waves and wakes. If the remote power method is used, consider water conditions. 

An ambient water sample collected near the sediment surface, close to the UltraSeep 
location, is also recommended for a "baseline" chemical reference. Divers can make the 
water sample collection immediately before insertion of the meter or after suspended 
sediments have cleared. 

Figure 17. Seepage meter set into sediment up to flange. 

Data Collection and Analysis 

Downloading Data 
Connect computer(s) to the ESM-1 and the MiniLogger as previously described in 
"Preparing to Communicate with Meter." Procedures for downloading data from the 
meters are in Appendix H. Check to confirm that the position of the selector valve cycled 
properly. Use the "openpipe" ftjnction after downloading data to make sure that data are 
on port #6 (see Appendix H). 

Plotting Data 
Microsoft* Excel is used to process the ESM-1 and MiniLogger data. A template file, 
"Seep meter Excel Template.xls," processes the ESM-1 data. A template for the 
MiniLogger "Minilogger Excel Template.x," processes the raw ultrasonic flow data. 
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ESM-1 data processing instructions are on the "raw data" sheet of the "Seep meter Excel 
Template" and the "processed" sheet of the MiniLogger template. Data processing 
instructions are in Appendix I for the ESM-1 and Appendix J for the MiniLogger. 

Maintenance 
Thoroughly rinse the UltraSeep with freshwater after retrieval, including the interior of 
the funnel. It is important to flush the inside of the ultrasonic flow tube; Use a garden 
hose placed over the outlet tube on the top of the housing, flush the inside. Rinse the 
sample tubing with DI or freshwater by extending the disconnected inlet sample line 
going to the funnel. Place the extended line-end into freshwater and run the 
"IminPump.esm" program or the "Clean4.esm" program for a longer flush. 

Fully charge the battery after each use and, periodically, to maintain battery strength; 
refer to the "Charging Battery" section. 

It is highly recommended that you unload the PharMed tubing from the peristaltic pump 
head to prevent permanent deformation and weakening during long storage. Inspect this 
section of tubing before deploying the UltraSeep, especially if it has been stored in a 
loaded state or if it is getting old. Check housing 0-rings periodically; clean and silicon 
grease them, if necessary. 
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APPENDIX A: Trident Checklist 

Water Sampling 
•   Adaptor tubing (Tygon) 
•    Syringes (vacuum pump?) 
•   Vials & label 
•   Refractometer 
•   Alconox® and DI water 
•   Haz Waste Container 

Temperature Measurement 
•    Serial Adaptor Cables 
•   Battery (9V) 

Conductivity Measurement 
•   Field computer-FC4000 
•   RS-232 adapter cables 
•   Floppy disk 
•   Stringpot cable 

GPS 48 
•    Site GPS coordinates 
•    Spare battery (AA) (4) 
•   RS-232 extension cable 

Trident 
•   Cable Assembly 
•   Push-pole sections 
•    SCUBA tank(s) and reg 
•   Pneumatic oil 
•   Trident kit box 

Boat Stabilization 
•   Anchors (3) 
•   Lines (3) 

Laptop 
•     Power cord 
•     Quad serial card 
•     RS-232 adapter cables 
•     MATLAB® program 
•     Locale-chart Chart View 

Other/Misc. 
•     12-V car battery 
•     750-W power inverter 
•     Teflon® tape and zip ties 
•     Cart & secure lines 
•     Tarp 
•     Logbook 
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APPENDIX B: Trident Software Operational Instructions 

Introduction 

This document contains and describes the operational instructions for using the Trident Probe Software. It 
is not meant to be a reference source for the corresponding MATLAB® source code. 

Setup And Installation 
To run the Trident Probe software, at least a basic version of MATLAB® must be installed. The Trident 
Probe software does not use any special MATLAB® toolboxes, however the software was vmtten using 
MATLAB® version 6.0.0.88 (R12) and should probably be run on similar versions as internal functions and 
fimctionality changes that occurred with subsequent releases might cause parts of the software to not 
fiinction correctly. 

MATLAB Installation 
For specific instructions on installing MATLAB®, please see the MATLAB® documentation. 

The Trident Probe Software Installation 
The Trident Probe software (the MATLAB® m-files and such) is currently located in the C:\trident 
directory on the trident-one computer. The only subdirectory actively used by the software is the datafiles 
directory. After a data capture is performed, the data are written to flat files in this directory that must exist 
before running the data capture portion of the Trident Probe software. 

In addition, the Trident Probe software help files are located within MATLAB®'s directory structure so that 
they can be read from within MATLAB®. On trident-one, these files are located in the 
C:\matlabRl 2\help\trident directory. 

Some third-party files existing within the Trident Probe software directory are also needed: the .bin files are 
the map files. Currentiy only sdbay.bln exists, but contains the latitude/longitude coordinates for San Diego 
Bay. The uigetfiles.* files can be used to display an open files dialog and allow the user to select more than 
one file. This file will be useful in creating an application to read the raw data files generated by the Trident 
GUI. 

Running The Trident Probe Software 

Launching the Program 
To run the Trident Probe software, first launch MATLAB®. Then, if the file, trident.m, is not located in 
MATLAB®'s search path, you will have to add it to the search path to keep from manually having to 
change into the C:\trident directory every time you start MATLAB®. 

To add it to MATLAB®'s search path, follow these steps: 

1. From the main MATLAB® window, click File » Set Path. 
2. Click the Add Folder button. 
3. Using the navigation window that pops up, navigate to the directory you wish to add to 

MATLAB®'s search path. In our case, probably C:\trident. 
4. Click OK to accept the selected path. 
5. The previously selected path will now appear at the top of MATLAB® search path list. 
6. Click Save to save the changes. 
7. Click Close to exit the Set Path window. Note: all changes take effect immediately. 

At this point, if the path was set up correctly and all the files are located in the specified directory, the 
Trident Probe software should be executable by typing the word 'trident' at MATLAB®'s » prompt. 
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The Trident Probe GUI should now be displayed as shown below: 
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Configuring the Trident Probe Software Preferences 

The user should probably configure any preferences he/she would like before running the data collection 
portion of the program. Click Edit » Preferences from the menu bar. 

The preferences menu displays as shown in the figure below. 

If the Trident Probe software is being run for the first time, the default settings display. After changes have 
been made and saved, a file called prcferences.mat is created and loaded on subsequent launchings of the 
Trident Probe software. If this file is ever deleted, the default settings are once again used. 

If COM port changes are made, as noted above, they are immediate. For this reason, the availability of the 
preferences menu is disabled during data acquisition. 

The user can select the default map that displays upon the starting of the application. This display is useful 
if the application is being heavily used in a certain region and keeps the user from having to continuously 
manually change the location map. A small picture of the map should display in the window to let the user 
see what the selected map looks like. 

Two checkboxes are to the right of the map display. The first checkbox defines whether the application 
should prompt the user before exiting. The second checkbox defines whether or not the application 
confirms file deletions. 

The default color bar settings allow the user to choose the number of colors used by the color bar. The 
higher the number of colors means a smoother transition (i.e., "fading" from solid red to solid orange) 
between data values, but also means that "close" data values will have very similar colors. The lower the 
number of colors means a very choppy and abrupt (i.e., jumping from solid red to solid orange) transition 
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between data values and means that even close data values may appear completely different or have 
identical colors, depending on where the color index lies in comparison to the data set. 

It also allows the user to specify the minimum and maximum default temperature settings for the 
temperature and conductivity plots. These values can also be set via the main Trident Probe software 
window. These values, if changed, are saved to the preferences file. 

By changing the Default Probe setting, users can specify what data they want to plot. They can also change 
what they want to plot via the main Trident Probe software window, but unlike the min/max 
temperature/conductivity values, this change is not saved to the preferences file. 

Finally, the user can specify the maximum number of data points allowed in the temperature and 
conductivity plot windows. Two sections exist, one for when the probes are active, and the other for when a 
data capture is performed. 

J Trident Preferences 

Measuring Device: COM Pott; 

GPS Receiver 
Temperature Sensor 
Conductivity Gauge 

  M 

Default Map: 

San Diego Bay jj 

C0M5 
COMG 
C0M7 

Warning:  COM port 
changes are immediate. 

M 

Default Colorbai Settings: 

Number of Colors: 64 

Max Colotbar Temperature (celcius):   | 30 

Min Colorbar Temperature (celcius): 1 

Max Colorbar Conductivity [milliSlemens):     40 

Min Colorbar Conductivity [milliS iemens):     16 

n Confirm application exit 

R Confirm file deletions 

Default Piobe: 

I Temperature   !T| 

Max. Activate Plot Points: 

T empetature:  j 45   I 

Conductivity:     45   |; 

Max. Capture Plot Points: 

Temperature:  I 60   i. 

Conductivity:   I GO   , 

Save & Close j 

Capturing Data with the Trident Probe Software 

Before data capturing can be performed, the three necessary serial devices, the GPS receiver, the 
Temperature probe, and the Conductivity probe should all be powered on and ready for use. In the case of 
the GPS receiver, tone must ensure that the device has acquired the needed satellite signals and is ready for 
use. The necessary cabling must be connected to the Trident probe. Thorough and detailed instructions 
on how to connect and power these devices begin on page 11 of this document. 

To begin the data capture, the probes must first be activated. To do this, click the Activate Probes button. 
Note that data capture refers to the actual portion of running the software where the software is 
writing the data to the flat files (and when finished will display the color shaded plot accordingly). 
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Probe activation, merely means the probes are turned on and the data transmitted via the serial 
cables is being received and plotted by the software. While the probe activation should be done after the 
Trident Probe has been deployed and is firmly in the sediment, it is not required. If this is not the case, the 
GPS reading taken at the onset of the probe activation may differ from the actual GPS reading taken at the 
onset of the data capture. 

With the probes activated, the Temperature and Conductivity plots will begin plotting the data transmitted 
from the probes. The Conductivity reading should stabilize rather quickly, while the Temperature plot 
might need a minute to stabilize. Temperature stability is essential for capturing correct and valid data 
because during the data capture phase the data from the probes arc written out to the flat files at 1 Hz. The 
same data is saved internally to MATLAB* and used to calculate and create the color-shaded dots in the 
Data Collection Points window, which are averaged over the entire span of the data capture, i.e., the 
temperature curve should decay exponentially before stabilizing. If the data capture is performed while the 
probe readings stabilize, the average value computed by MATLAB* will be higher than the real-world 
value because the higher values on the decaying portion of the exponential curve have been used to 
calculate the average. Once the temperature readings have stabilized, i.e., the graph is essentially 
horizontal, a successful (meaning the data collected will be true and valid) data capture can be performed. 

Currently, the MATLAB* code for the Temperature and Conductivity data plots is hard-coded to hold 30 
data points before scrolling off the plot. 

To begin the data capture, make sure a Station ID has been specified and click the Capture Data button. 
The current location/date/time will be received from the GPS receiver and stored. The location values 
display in the relevant fields in the GUI. The data plots clear and the internal Temperature and 
Conductivity buffers reset to zero. At this point, the software collects and plots the transmitted data at 1 Hz. 
The data is plotted to the Temperature and Conductivity plot windows and also written out to the flat files. 
The timer in the upper left comer display how long the data capture process has been running and when 
sufficient data have been collected for this point (usually no more than a minute); click the Stop button to 
end the data acquisition process. At this point, the flat files will be closed for writing and the average 
temperature and conductivities will be calculated. Depending on what plot type is specified for the Data 
Collection Points window, a color-shaded dot representing either the Temperature or Conductivity will 
appear at the location specified by the GPS reading. For this reason, a map of the harbor or coastline where 
the Trident has been deployed is useful for telling the user where exactly the data point is located. The flat 
files are stored in a subdirectory from the Trident files called data_files. The filename format is the Station 
ID followed by a date/time stamp. The extension placed on the file is .raw, for raw data. 

This process can be repeated for as many locations the user needs to evaluate. Currently, the map image 
with the color-shaded points cannot be exported to a picture file, except as a "Print Screen" option. 

Other Trident Software Options 

The Data Collection Points window has a zoom feature that, when enabled, allows the user to zoom in on 
specific areas. This feature is extremely useful if a coastline or harbor map is being used as the user can 
then zoom-in on the data points collected and see exactly where they lie in relation to other harbor/coastline 
landmarks. 

This map window also has a plot-type feature that allows the user to switch back and forth between 
temperature and conductivity plots. Simply changing the plot type from the drop- down list will update the 
map with the correct data. The color bar has a text field for setting the lower and upper limits of the color 
bar. For these setting to take effect, the user must change the limits to the values needed and then select the 
plot type from the plot type drop-down list. This change causes the software to recapture the entered limits 
and adjust the color bar and data map accordingly. 
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The Notepad section is useful for noting specific information about a certain data run, or data collection 
point. It is not required to be used; however, if it is, the data contained there will be written to a flat file 
when the program is closed. 

Trident GUI Layout 

The layout for the GUI is shown below: 

Time (seconds) 

Temperature Plot 

Time (seconds) 
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Section 1 - The Control Buttons 

Station ID Field: The Station ID field allows for a unique identifier to be associated with the acquisitioned 
data. The name in this field is used as the first part of the filename of the acquisitioned data. Please use "_" 
(underscores) instead of spaces. The full filename consists of the string from this field and a date/time 
stamp. The default extension for these data files is ".raw". Since this field is required, data capturing cannot 
occur until this field is populated; however, since the date/time stamp for each file is unique, no error 
checking is done to ensure that this field is changed between point acquisitions. 

Activate Probes: The Activate Fields button is a toggle button, and thus has two states, on and off. Upon 
the first pressing of this button, the COM ports are assigned to each of the measuring devices: the GPS 
receiver, the Temperature probe, and the Conductivity probe. Subsequent activations do no reassign the 
COM ports. The GPS receiver is queried once and the Latitude/Longitude fields (as described in Section 2 
below) are updated to reflect the current position. The Temperature and Conductivity probes are then 
queried at a frequency of 1 Hz for as long as this button is activated. The data read from the probes are 
plotted continuously and in real time in their respective axes in the lower right comer of the GUI. The 
Temperature and Conductivity fields (as described in Section 3 below) are updated to reflect the current 
probe readings. This button can be deactivated in two different ways: by clicking the button to the off 
position, or by clicking the Capture Data button. 

Capture Data: This button is only enabled when the probes are active, i.e., when the "Activate Probes" 
button is on. As soon as the data capture begins, the button is again disabled, the temperature/conductivity 
plots and the counter timer are reset to empty plots and 00:00, respectively. The functionality of this button 
is identical to the Activate Probes button, except for the COM port assignments. In addition, the data from 
the probes are written to a .raw data file for later analysis. The timer to the right of the Stop button displays 
the length of time the data have been captured. Data are captured until the Stop button is pressed. 

Stop: The Stop button is only enabled after the Capture Data button has been pressed and is immediately 
disabled after being pressed. After this button has been pressed, the mean temperature and conductivity are 
calculated for the current data set, and depending upon what data plot type is specified (as described in 
Section 2 below), the mean is plotted as a point on the map with colored shading that dictates the value at 
that point. 

Section 2 - Data and Map Functions/Features 

Zoom: This button toggles the zoom feature on or off When on, the user may either click on the map to 
zoom in on a specific point, or may click and drag the mouse to select an area on which to zoom. Right- 
clicking the mouse will zoom out. Clicking the zoom button again will turn the zoom feature off and freeze 
the map at the current level. 

Current Location: The current latitude/longitude displays in decimal degrees. This field is only updated 
once per probe activation or data capturing, so the GPS receiver does not need to be held in place above the 
deployed Trident probe once the position is captured. Once the temperature and conductivity plots show 
data plotted, the GPS receiver may be moved. 

Data Plot Type: This drop-down list gives the option for what data is to be plotted in the data map. If 
Temperature is selected, any collected temperature data are plotted and after capturing data is complete, the 
newly collected temperature data arc also plotted. The converse is true when Conductivity is selected. 
Because the map is updated after a capture cycle is complete, this feature is temporarily disabled during 
data capturing. 

Map: The data plot consists of color-shaded points that represent either the temperature or conductivity at 
specific coordinates on the map. The data displayed are determined by the selection in the data plot type 
field. 
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Color Scale and Limits: The lower limit field specifies the lower limit of the color band and the upper 
limit specifies the upper limit of the color band. The color band is not updated until either a data capture is 
performed or an option in the data plot type is selected or re-selected. 

Section 3 - Temperature and Conductivity Data/Plots 

Probe Data: As the probes are queried, whether in activation mode or data-capturing mode, these fields 
display the last value read from the probes. 

Plots: As the probes are queried in activation or data capturing mode, these plots track the changes. The 
time axis always starts and stays at zero, so the points are "packed" in from the right. These plots are reset 
(erased) each time the probes are activated or a data capture is performed. 

Trident Supplemental Information 

The temperature probe returns the temperature in degrees Celsius. 

The conductivity probe returns the conductivity in milliSiemens. 

The porewater probe allows for the extraction of water (for sampling) while the probe is deployed. 

The air hammer acts like a jackhammer in that it assists the probe to be inserted further into the sediment. 

GPS Receiver 

The GPS receiver uses the following: 

• Port COM4 - Currently has a splitter to share the GPS data w/ another COM port (e.g. 
C0M7) that would be read by another mapping software program (e.g., ChartView™). 

• The black, 9-pin serial cable with the red velcro strap. 
• The 9-pin serial splitter was created for use with the receiver so that the to National 

Marine Electronics Association (NMEA) output can be used simultaneously in 
MATLAB® for the Trident program and ChartViewTw, which currently contains the fiill 
map of survey area, (optional). 

• Four AA batteries. 

The GPS receiver generates the following serial output according to NMEA standards. The only lines used 
by the Trident GUI are marked in red as follows: 

$GPRMC,POS_UTC,POS_STAT,LAT,LAT_REF,LON,LON_REF,SPD,HDG, DATE,MAG_VAR, MA 
G_REF*CC<CR><LF> 

POS_UTC  -  UTC  of  position.  Hours,  minutes  and  seconds  [fraction 
(opt.)]. 
(hhmmss[.fff]) 
POS_STAT - Position status. (A = Data valid, V = Data invalid) 
LAT     - Latitude  (1111.11)  (ddiran.ram - whole degrees  and decimal 
minutes) 
LAT_REF - Latitude direction. (N = North, S = South) 
LON - Longitude (yyyyy-yy) (dddmm.mm - whole degrees and decimal 
minutes) 
LON_REF - Longitude direction (E = East, W = West) 
SPD  - Speed over ground, (knots) (x.x) 
HDG  - Heading/track made good (degrees True) (x.x) 
DATE   - Date (ddmmyy) 
MAG_VAR - Magnetic variation (degrees) (x.x) 
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MAG_REF - Magnetic variation (E = East, W = West) 
FIX_MODE - Position Fix Mode ( 0 = Invalid, >0 = Valid) 
SAT_USED - Number Satellites used in solution 
HDOP   - Horizontal Dilution of Precision 
ALT  - Antenna Altitude 
ALT_UNIT - Altitude Units (Meters/Feet) 
GEO  - Geoid/Elipsoid separation 
G_UNIT  - Geoid units (M/F) 
D_AGE  - Age of last DGPS Fix 
D_REF  - Reference ID of DGPS station 
CC   - Checksum (optional) 
<CR><LF> - Sentence terminator (carriage return and line feed) 

The tags used by the Trident GUI are in bold above. For accurate data plotting, any coordinates in the 
southern or western hemispheres are stored as negative numbers; however, are displayed as positive 
numbers since the GUI specifies the direction. 

Temperature Probe 

The Temperature probe uses the following: 

• Port COM5 

• A heavy black cable with a round, 4-pin connector (the four pins form a square) on one 
end connected to a 25-pin to 9-pin gray serial cable on the other end. A 9-V battery to 
power the SBE temperature probe is connected via a red/black twisted-pair of wires 
attached to the gray 25-pin to 9-pin converter. 

• The serial output from the temperature probe is in decimal degrees Celsius (format: 
cc.cccc). 

Conductivity Probe 

The Conductivity probe uses the following: 

• Port COM6 
• A gray serial cable with 9-pin connectors on each end. 

• 
The GeoProbe® FC4000 field computer. 
Power supplied by the field computer (llOv). 

To get the FC4(X)0 field computer into the correct mode to transmit data via the serial port, turn the unit on 
and select the following menu options: 

1 - Conductivity 
1 - For SC4(X) 
2 - To bypass all tests (if this is indeed the user's wish) 
1 -For Imrods 
1 - For Wenner type conductivity probe 

The serial output ft-om the conductivity probe is in decimal milliSiemens; however, since the decimal is not 
transmitted with the data, the number is divided by 100 to get the actual decimal, (serial format: cccccc, 
program format: cccccc) 
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Appendix C: Checklist fior UKraSeep 

Prep and Sampling 
•     Log Book 
•     Manuals (ESM-1, MiniLogger, Pump, Valve) 
•     Ct Chargetek 500 Battery Charger 
•     Cleaning Solutions 
•     Extension Tubing For Sample Line From Funnel 
•     Sample Bags (Alltech # 41012) 

UltraSeep 
•     Meter (with Charged Battery) 
•      Lift Bridle 
•     Wheels and Pins 
•     Cover for MiniLogger Display 
•     MinLogger Display Cover in Place 

•     Dummy Plug for MiniLogger RS-232 BC Connector 
•     Misc Dummy Plugs 

Computer and Cables 
•     Computer(S), UltraSeep Programs, Power Cords 
•     ESM-1 Power/Com Interface Box 
•     100' ESM-1 Com Cable 
•     100' Cable for MiniLogger with Dummies 
•     RS-232 Adaptor Cable with DB-9 
•     External Switch for Pump to Put into Ext RS-232 
•     2 X 12-V Small Batteries to Power Solenoid Valve 
•     GPS 

Deployment/Retrieval 
•     Primer Bulb 
•     Marker Buoy 
•     Tie Wraps 
•     Lift Bags 
•     Ice Chest for Samples 
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APPENDIX D:U|tiiSeepPre-DeplbyirTOnt 

Refer to "Checklist For UltraSeep" for Necessary Items 
Battery Charged (Check Voltage?) 
Pump Tubing Loaded in Pump Head 
Intake Sample Line Attached at Funnel 
Sample Lines Attached to Bags 
Valve Stems on Bags Open (Pulled Out) 
Pouches Zip-Tied to Top to Retain Bags 
MiniLogger Programmed 
ESM-1 Programmed with Proper Delay and Valve Periods 
Start and Sample Sequence Start/End Noted in Log 
Release Shackle Attached to Bridle 
Wheels Removed 
Remove Air Bubbles Trapped in Funnel 
Prime Flow Tube 
Use Caution Not to Get New Air Bubbles Inside Funnel 
Zero Flow Tube 
Connectors/Cables Dummy Plugged 
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APPENDIX l:UlBiSeep Cleaning 

CLEANING SCHEDULE (per line) 
• 4 minutes detergent (2% Alchonox® or RBS) 
• 2 minutes 10% acid (if necessary) 
• 2 minutes 18 mega-ohm deionized (DI) water 

1) Prepare cleaning solutions in carbuoys: 
a. 10 liters of 18 mega-ohm deionized water 
b. 5 liters of warm 2% RBS or Alconox®, depending on analysis 
c. 1.5 liters of 10% nitric acid if analyzing metals 

2) Attach the extension tubing to the detached sample line from the funnel. Place this line in 
the detergent container. Place a cup under each sample on the UltraSeep as fluids will 
drip from lines. 

3) Make sure tubing is loaded in the UltraSeep's peristaltic pump head. Power-up UlfraSeep 
and connect computer to ESM-1 using interface box as described in "Communicating 
with Meter." Select "Shortcut to ESM" and upload "Clean4.esm" (see Appendix E). 

4) Start "Clean4" and inspect lines to make sure fluid is flowing. If there are flow problems, 
try raising the container to reduce the head. 

5) Have the acid and DI containers together for the next portion of the cleaning process as 
the intake line from the acid container will be switched halfway through the 4-minute 
cycle to the DI container for each sample line. The use of a stopwatch is recommended. 

6) Load the Teflon® sample bags into the mesh pouches with the valve stems pointing 
inward, through the mesh, and push onto sample tubing. Pushing the valve stem onto the 
tubing will close the valve stem. It is necessary to pull the valve stem out to collect 
samples. 
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APPENDIX F:l\lllniy)ggerSei-Up 

Note: The following should be done before programming the ESM-1 

Select Shortcut to "Flowm" from computer desktop 
Connect MiniLogger com cable and RS-232 cable to computer 
RS-232 
Hit Enter to get prompt (takes a while or hit again) 
Type in "menu" (repeat typing in "menu" if you do not get it the 
first time) 
Go to METER FACILITIES (right arrow to select) 
Scroll to datalogger control (use up/down arrows then right 
arrow) 
Select "CLEAR DATALOGGER" > YES 
Go back to main menu (use left arrow) 
Select 2 CHANNEL FLOW using right arrow 
Select CHANNEL 1 FLOW TUBE 
Select Datalogger setup 
Select Datalogger mode 
Select "Yes" for MEMORY 
Once deployed, zero meter and save value as new zero value 
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APPENDIX G: ESM-1 Programming Highlights 

Two programs are used for the programming of the ESM-1 controller/logger. A context editor is needed to 
write/change the programming scripts for the ESM-1; we use ConText Editor. The other program is 
Hyperlink, which communicates with the ESM-1. 

The following are major areas for attention (also see following page): 

Context Editor 
Edit "Main" File: 

Main Loop: 

Edit "Pump" file 

ESM-1 Uploads 

Check the number of "repeats" for the startup delay and change to 
anticipate delay from the time of downloading program to ESM-1 to 
the time it begins sampling. Each repeat = 5 minutes, ex. 36 repeats = 
3 hours (default). 
Change filename for new site in two places. 

Change the pump loop filename in 6 places at end of sub routine. 

Outside repeat is the time between switching valves. One repeat 
minutes, ex. 15 repeats = 2 V2 hours. Change, if necessary. 
Change filename for new site. 

10 

Connect ESM interface box to computer and ESM 
"Shortcut to ESM", hit enter, wait for prompt,  and type in "cd 
/store/eep/micro" to go to program area of ESM-1 
Type "dir" at new prompt to see list of programs on ESM 
Type "del 'filename"' to get rid of files if more memory needs to be 
cleared on the ESM for the new site (need 5000 bytes free for one tidal 
cycle at 5-minute sampling) 
Type "upload 'filename"' for pump file at prompt (name you want it to 
be called) and hit Enter. Should say "Ready to receive text" 
Go to Transfer menu, click "send text file" 
Select file to upload from C:\ESM (look at all file types) and open 
template file to upload to ESM-1. Inspect file while uploading to see if 
everything looks good. 
Hit Cntrl-C when done. 
Repeat from step "5" for uploading new "main" file. 
To run ESM, type in filename for "main" and hit enter. 

EDITING ESM-1 PROGRAM FILES 

The following is a portion of the "main" file for programming the ESM-1. Nine places require attention: 

Legend: 
I repeat: used to delay water sampling sequence. Repeat = 5 minutes for "main" file, 10 minutes for 

"dump" file. 
I site name: change in eight places and "save as" new file. 
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APPENDIX H:UitraSeep Data Downloading 

Downloading data from the ESM-1 

• Hook up com cables 
• "Shortcut to ESM" and hit Enter to get prompt 
• Type in "cd cf' to change the directory to Compact Flash (ESM-1 memory) to see if 

filename setup during programming is hsted. 
• Type "extract /store/cf/'filename', synopsis, compact" but DO NOT HIT ENTER 
• Go to "Transfer Menu">"Capture Text"> rename if you want new name. 
• Hit Start then Enter 
• Go back to "Transfer" menu > "Capture Text" > Stop 

Downloading data from MiniLogger 

• FLOWM shortcut 

• Type "logger" at prompt, but DO NOT HIT RETURN 

• Go to "Transfer" > "Capture Text" > type in filename for site 

• Click "Start" > Enter 
• When data stream has stopped, go back to "Transfer Menu" > "Capture Data" > 

"Stop" 

'Open Pipe" 

• Run ESM Shortcut 
• Type "cd eep/micro" at prompt <enter> 
• Type "initserial 3,9600" to initalize port 3 (valve port on ESM ) <enter> 
• Type "digitaliolO, set" to turn on converter ("digitaliolO,clear" to turn off converter) 

<enter> 
• Type "openpipeS" <enter> 
• Type "go_", use 1 through 6 in the blank to advance valve to position <enter> 
• Type "cp" to ask where the valve position is presently located <enter> 
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APPENDIX I: ESM-i DATAPpOTTlNG 

Quick Check 

In Microsoft® Excel, column A is flow, B is pressure (depth), and C is temperature. 

• Open Microsoft® Excel 
• Open file (look/find file in ESM folder where file is stored); it should appear as "(site 

name)syn_compact.dat" 
• Use "delimited" and "comma" when dialog box opens 

Highlight the particular column you want to graph (a, b, or c) 
Go to View > Insert Menu > Line graph 

• 

Data Processing: 

• Open the appropriate " syn_compact.xls" and the "Seep meter Template.xls" files. 
• Copy only the data values of A, B, and C columns of "....syn_compact.xls" file into the 

"raw data" sheet of the template file. Instructions are on the "raw data" sheet of the 
template and are as follows: 

NOTES 
1. Delete old data from yellow box (do not delete time column) 
2. Paste new raw data (numbers only) into yellow box (from ESM syn_compact.xls file)—use  "paste as 
values" (clipboard icon with "12") 
3. Enter new start date/time in blue box (date/time for beginning of ESM file) 
4. Enter in the row number for start time of sample #1 in the red box above 
5. Make sure autofilter is turned off in Parse Data sheet 
6. Delete old data from Parse Data sheet 
7. Copy data from Raw Data sheet (including date/time) 
8. Line up the first row of raw data at the line specified in red box above in the Parse Data sheet 
9. Paste as values on the Parse Data sheet (clipboard icon with 12) 
10. Put cursor at top of column one and autofilter data on Parse sheet for column one using a filter of 1 
(use blue arrow at top of column one) 
11. Delete raw data in purple box on the Formatted Data sheet 
12.Copy the filtered data including time from the Parse data sheet (not including pump status) 
13. Paste as values on the Formatted Data sheet (clipboard icon with 12) 
14. Adjust plot ranges in plot sheets to match the length of the data in the Formatted Data sheet    (in 
command line {fx}) 
15. Save the file under a new name that corresponds to the deployment name (Save As) 
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APPENDIX J: MiniLogger Data Plotting 

1. Import data file from logger in into Microsoft® Excel worksheet 
2. Determine deployment start time-remove first 2 hours of data (adjustment period after 

deployment) 
3. Check error codes, signal strength, and sound velocity (Vj) in output file to assure proper 

operation of meter 
4. Use average flow data to convert flow rate to specific discharge as follows: 

a. Convert average flow rate to velocity by accounting for area of flow tube (area 
of flow tube = 0.7129 cm2) 

b. Relate this velocity to velocity in funnel (ratio of funnel to flow tube is 
0.0003411 for fiinnel area of 2090 cm2 

c. Convert fi-om cm/sec to cm/day by multiplying by 86400 sec/day 
d. Optional—convert to rate by adjusting for area of discharge for given time 

5. Plot data—data usually plotted with tide 
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